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For in vitro neutrophil functional assays, isolated neutrophils are typically used as the standard input.
However, isolated neutrophils show a varying and limited lifespan as short as only a few hours ex vivo,
significantly shorter than the lifespan of neutrophils in vivo up to 3-5 days. The limited assay time
window leads to a significant loss of donor-specific information, which is attributed to non-specific
activation (i.e., baseline cell death without operator-defined stimuli) of neutrophils after being pulled out
of whole blood. In addition, due to neutrophils’ inherently high sensitivity, removing neutrophils from
whole blood generates operator-derived inconsistencies in the information extracted from the assays. Here
we present a method - named “μ-Blood” - that supports long-term (days) multiple phenotypic readouts of
neutrophil function (including cell/nucleus morphology, motility, recruitment, and pathogen control) using
a microliter of unprocessed whole blood. In autologous whole blood, neutrophils show sustained
migration and limited non-specific activation kinetics [<0.1% non-specific activation >3 days]. By
contrast, isolated neutrophils show altered activation kinetics [10-70% non-specific activation in 3 h and
diminished (>90%) recruitment]. Using unprocessed whole blood, μ-Blood captures a distinct neutrophil
functional heterogeneity between healthy donors and cancer patients against microbial stimuli through
days-long assays, showing the potential for in vitro immune assays with improved extraction of
donor-specific information and assay consistency over time.

Introduction
The immune system is central to human health and disease1. Immune functional information ranging from
phenotypic level to molecular level has a long history of being studied and used as biomarkers in
medicine. Whole blood immune profiling (e.g, flow cytometry, clinical cell counts, and other cellular
markers) has been used in patient stratification2 and immune signature studies3–5. Whole blood immune
profiling provides critical data for clinical decision making, however, these assays provide only a
snapshot of the chemical and physical markers of the immune cells in whole blood. In comparison,
immune cell functional assays - interrogation and quantification of immune cell phenotypic response
against stimuli (e.g., drug/pathogen challenge), provide valuable and additional biomarkers on top of the
snapshot information from whole blood immune profiling, enabling a more complete set of information
for in vitro diagnosis (IVD)6 and drug/therapy screening7,8.

While in vivo tests (e.g., mice, zebrafish)9 are available and the current gold standard for immune cell
functional assays, in vitro assays allow improved physical, optical, and biochemical access/challenges and
more importantly, the use and interrogation of primary human cells directly from patients and thus a
promising pipeline that leads to personalized/precision medicine10. In the in vitro regime, various
microfluidic systems have been developed to perform whole blood immune profiling (including
genomics, transcriptomics, proteomics, and physical markers)11–13 and immune cell functional assays (e.g.,
cell-to-cell, cell-to-environment)8. In spite of this progress, the inherently high sensitivity of immune cells
and the observer artifacts in an assay still limit the extraction of donor-specific information. In addition,
these limitations compound the resolution (e.g., inherent single-cell heterogeneity versus variation caused
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by artificial environmental factors) and parallel comparison of results from different sources (e.g.,
experiments, operators, and labs)14,15.

In microfluidic immune cell functional assays, the target immune cells are typically captured13,16–18
isolated19 from whole blood and then cultured/interrogated in an artificial media environment. These
operations expose the sensitive cells to an altered environment compared to the original whole blood
environment that includes autologous signaling molecules20,21, other constituent cells [e.g., red blood cells
(RBCs)22, platelets23,24, innate-adaptive crosstalk25], and physiopatholgolcially defined oxygen
homeostasis/kinetics26. Recently, whole blood has been used directly as the input in microfluidic immune
cell functional assays to improve efficiency, (i.e., sample-to-answer turnaround time) and more
importantly to reduce the observer artifacts. However, whole blood still needs to be pre-processed (e.g.,
RBC lysis or dilution with artificial media and animal serum)6 and/or analyzed in/with artificial buffer
solutions13. Due to the altered and/or loss of the in vivo environmental factors, in vitro immune cell
functional assays still suffer the limited consistency and donor specificity of the information extracted
from the assays.

Here we develop a method - named μ-Blood - for neutrophil functional assays with a microliter of
unprocessed (i.e., raw) whole blood, aiming to minimize the observer artifacts and further improve the
extraction of donor-specific information and assay consistency. μ-Blood is established on a newly
introduced sub-branch in open microfluidics known as Exclusively Liquid Repellency (ELR)-empowered
Under-oil Open Microfluidic System (UOMS)27–33. μ-Blood allows immune cell functional assays to be
performed using a micro- or sub-microliter (per testing unit) of unprocessed whole blood and therefore,
with the donor-specific autologous microenvironment preserved. In addition, removal of the whole blood
processing steps (e.g., blood cell lysis, blood dilution, cell capture/isolation) reduces the experimental
variability and improves the efficiency, consistency, and throughput.

We validate μ-Blood with neutrophils - highly sensitive immune cells - by directly comparing whole
blood with isolated neutrophils. The lifespan of isolated neutrophils is short and is complicated by
non-specific activation (10-70%) - the spontaneous activation of neutrophils to cell death (including
apoptosis and NETosis) due to the altered environment from in vivo to ex vivo - occurs in only a few
hours. By contrast, neutrophils are stable in their autologous whole blood with minimal (<0.1%)
non-specific activation for more than 3 days. Using μ-Blood, blood samples from healthy donors and
cancer patients are interrogated and compared through 24-h and 6-day assays. The results reveal a distinct
neutrophil functional heterogeneity between healthy donors and cancer patients - neutrophils from cancer
patients are significantly desensitized compared to the cells from healthy donors. Specifically, cancer
patients show: i) upregulated neutrophil count in whole blood [average 4 ± 2 million/mL (cancer) versus
average 3 ± 2 million/mL (healthy)]; ii) similar migration speed (average 0.2-0.3 μm/s) from fresh blood
toward fMLP (N-Formylmethionine-leucyl-phenylalanine - a standard neutrophil chemoattractant) at
early stage (<3 h) but, significantly lower migration speed (average <0.1 μm/s) in response to live bacteria
[Staphylococcus aureus (S. aureus)] at early stage (<3 h) compared to healthy donors (average 0.3 μm/s);
iii) (average 60%) less recruitment at early stage (<3 h) then slowly increased recruitment to a similar
level but much lower activation rate [average 13% (cancer) versus average 72% (healthy)] at later stage
(~24 h); and iv) much longer “induction time” [>1 day (cancer) versus <1 h (healthy)] to respond against
microbial stimuli.

Results
The governing physics and open-fluid single-cell trapping - the key enabling function in μ-Blood
Microfluidics has been proved to be a powerful platform to support in vitro immune cell functional assays
due to its capabilities to handle small volumes (milliter to picoliter) of fluid, perform fluid dynamics
control at microscopic levels with high throughput and automation. Open microfluidics is a type of
microfluidic system with at least one solid barrier (e.g., ceiling and/or walls) that confines the fluid
removed and thus exposing the fluid to the ambient environment, e.g., air (single-liquid-phase open
microfluidics)34 or a secondary fluid (i.e., multi-liquid-phase open microfluidics)35. Compared to the
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traditional closed-chamber/channel microfluidics, open microfluidics comes with a predominant
advantage - the natural alignment with the open system standard in biology and biomedicine, allowing
free physical access to the system and samples on a device35. However, the broad adoption of open
microfluidics has been stymied due to the limitations of system stability (e.g., media loss via evaporation
and airborne contamination in single-liquid-phase open microfluidics) and functionality [e.g., limited
lateral resolution (millimeter-scale channels), low flow rate range, and the lack of fluid controls such as
on-demand reversible valves].

Fig. 1 Micrometer-scale under-oil microchannels prepared by Double-ELR under-oil sweep
distribution and the under-oil microenvironment. a, The physics and surface chemistry of Double-ELR
[i.e., under-oil water ELR + under-water oil ELR (with Young’s contact angle θ = 180o) on a chemically
patterned surface] and the operation of under-oil sweep distribution. In Double-ELR, oil and aqueous
media get absolutely locked onto its favorable surface [i.e., silicone oil to the PDMS monolayer covalently
bond to the surface; aqueous media to the oxygen (O2) plasma-treated glass], excluding cross intrusion of
the fluids to the unfavorable surface. Aqueous media can be rapidly, precisely, and losslessly distributed
to a Double-ELR surface with micrometer-scale lateral resolution by sweeping a hanging drop of media
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(at any size) across the surface. b, A camera photo of a μ-Blood device overlaid with silicone oil (5 cSt, 1
mL/well) and a three-dimensional (3D) model that illustrates the geometry of the under-oil microchannel.
c, A zoomed-in picture of the under-oil microchannel 3D model in (b) that shows the fine structures of the
under-oil microenvironment and the mechanism of open-fluid single-cell trapping. Blood cells get trapped
in the entrance plume defined by the contour line (i.e., a line of equal height) of a given cell size (e.g.,
RBCs). The space beyond the contour line in the microchannel has a channel height smaller than the
defining cell size. Defined by the unique under-oil microenvironment, cells bigger than the channel height
can only move into and through a microchannel via active cell migration.

Recently, UOMS (i.e., Under-oil Open Microfluidic Systems) - a sub-branch of multi-liquid-phase
open microfluidics with an oil overlay - gained fast growing attention and development30,36,37. Our group
introduced the ELR extreme wettability27,28,30 (Fig. 1a), where a liquid (e.g., aqueous media) is inherently
(i.e., surface texture and surfactant independent) and absolutely repelled (with Young’s contact angle, θ =
180o) on a solid surface when exposed to a secondary immiscible liquid phase (e.g., oil ) - to UOMS. ELR
transformatively improved the functionality of open microfluidics including micrometer-scale lateral
resolution (compared to millimeter-scale lateral resolution in other existing open microfluidic systems)
(Fig. 1b), open-fluid single-cell trapping (Fig. 1c), high flow rate range (comparable to blood flow in
circulatory systems), on-demand reversible open-fluid valves30, and new functions [e.g., autonomously
regulated oxygen microenvironment (AROM)32]. These advances in ELR-empowered UOMS together not
only make open microfluidics comparable to the closed-chamber/channel microfluidics but also
introduces new avenues to cellular27,28,30–33 and molecular38 assays in biology and biomedicine.

To perform immune cell functional assays in a microfluidic system, the key enabling function
required is to robustly trap the cells at single-cell level in a designated area and in the meanwhile allowing
cell migration and mass transport via diffusion/convection. In closed-channel microfluidics, single-cell
trapping can be realized by introducing a physical barrier (e.g., a filter membrane, a hydrogel plug) to a
microchannel or utilizing filter microchannels with the channel cross-section smaller than the size of a
single cell. Before the introduction of ELR-empowered UOMS30 to open microfluidics in 2020, the lateral
resolution of open channels was limited to millimeter scale due to multiple technical challenges (Section I
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in SI, Supplementary Fig. 1). In open fluid, single-cell trapping [e.g., mammalian cells (5-30 μm),
bacteria and fungi (0.5-5 μm), etc.] is difficult to perform with millimeter-scale open channels.

In μ-Blood, the under-oil microchannels with micrometer-scale lateral resolution [with or without
extracellular matrix (ECM) coating] can be readily prepared by an operation known as under-oil sweep
distribution enabled by Double-ELR30 (Fig. 1a, Fig. 2a). The lateral resolution of surface pattern in
ELR-empowered UOMS is defined by the surface patterning method, e.g., photolithography used in this
work (but not limited) at about 30 μm. Defined by the unique geometry of the Double-ELR under-oil
microchannels (Fig. 1c), a channel height (i.e., the thickness of the media layer or media + ECM layer in a
microchannel) less than 2.5 μm - defined by the Laplace pressure equilibrium of the system - can be
achieved spontaneously with a much larger channel width at 100 μm (Fig. 2b).

Here, we test a series of the Double-ELR under-oil microchannels for open-fluid single-cell trapping
in experiments (Fig. 2c,d). The microchannels consist of a straight channel connecting two circlular spots,
with the dimensioins written in the format of, e.g., 2-2-L0.5-W0.1 (w or w/o ECM), for 2 mm in diameter
of the spots, 0.5 mm in channel length (L) and 0.1 mm in channel width (W). The channel width of
interest in this study is ≤100 μm with a channel length ≤500 μm. Whole blood [white blood cells, 7 to 30
μm in diameter; RBCs, 7.5 to 8.7 μm in diameter and 1.7 to 2.2 μm in thickness; platelets, 3 to 4 μm in
diameter] and bacteria [S. aureus, 0.5 to 1.5 μm in diameter] are used and tested regarding the immune
cell functional assays. Without ECM coating, the channel height of 2-2-L0.5-W0.1 is calculated for 2.3
μm (Fig. 2b, inset). In this case, RBCs got passively pumped through the microchannel as a monolayer of
cells with the disc in parallel to the substrate surface, evidenced by the assembly, disassembly, and
re-assembly of RBC rouleaux (i.e., stacks of RBCs) before, in, and out of the microchannel (Fig. 2c, top
left). The following loading of S. aureus (GFP-labeled) at the opposite spot showed a confined entrance
plume due to the occupation of channel space by RBCs (Fig. 2c, top right). The other microchannels with
a smaller channel width of 30-40 μm all showed complete blood cell trapping (Fig. 2c bottom left) due to
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the reduced channel height to <0.3 μm (Fig. 2b, inset). It is worth noting that if the channel length is
smaller than 2× of the length of entrance plume (le), RBCs can be still passively pushed through the
microchannel (Fig. 2c, bottom right). In comparison, all the microchannels tested with ECM coating
trapped both blood cells and bacteria (Fig. 2d) due to the much thinner media layer compared to the
ECM-free conditions [Fig. 2b, inset; media layer thickness of 2-2-L0.5-W0.1 (w/o ECM) is 2.3 μm; media
layer thickness of 2-2-L0.5-W0.1 (w ECM) is 2.3 μm - 0.7 μm = 1.6 μm].

Fig. 2 Fluid dynamics analysis in the under-oil microchannel and experimental results of
open-fluid single-cell trapping. a, Schematics that show the four stages of fluid dynamics including
I-Right after sweep, II-(Laplace pressure) equilibrium, III-Add 1 μL/spot of media, and IV-(Laplace
pressure) equilibrium. Right after sweep (I), all the liquid layers take a nearly constant height-to-width
(H/W) ratio30 of 1/13. Driven by the Laplace pressure differential between the microchannel [ΔPmicrochannel =
γoil-media/Rchannel-length + γoil-media/Rchannel-width = γoil-media/Rchannel-width (with Rchannel-length → ∞), where ΔP is Laplace
pressure, γoil-media is the interfacial tension at the oil-meida interface, R is the radius of curvature] and the
spots (ΔPspot = 2γoil-media/Rspot), the fluid volume in the microchannel (Section II in SI, Supplementary Table
1) gets pumped out until the system reaches equilibrium (II). Adding an extra volume (1 μL in this work) to
a spot (III) breaks the equilibrium, pumping some volume back to the microchannel until the system
reaches a new equilibrium (IV). b, Theoretically calculated channel height as a function of channel width
for spot diameter of 2 mm. (Inset) A zoomed-in graph of the channel width ≤100 μm. For the
microchannels with ECM coating, the thickness of the ECM layer is described by “II-Equilibrium” and the
thickness of the media layer on top of the ECM layer can be known as the differential between
“IV-Equilibrium” and “II-Equilibrium”. For the microchannels without ECM coating, the thickness of the
media layer is described by “IV-Equilibrium”. c, d, Open-fluid single-cell trapping results in the under-oil
microchannels without ECM (c) and with ECM coating (d). The channel dimensions are the measured
values on a microscope (Supplementary Table 1, footnote). The channel oil-media boundaries on the
substrate are highlighted by the white dash-dotted lines. The entrance plumes (i.e., the surface area
occupied by the cells in a microchannel) are marked out by the contour lines (colored dashed lines: red -
whole blood; green - GFP-labeled S. aureus, blue - S. aureus stained with Hoechst). When the channel
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length is smaller than 2× of the entrance plume length (le), RBCs get passively pushed through the
channel.

Enabled by the micrometer-scale lateral resolution and the unique geometry of the Double-ELR
under-oil microchannels (Fig. 1c, Fig. 2a,b), blood cells and bacteria can be reliably and selectively
trapped (Fig. 2c,d) with free physical access to the samples of interest on a μ-Blood device (Fig. 1b). The
blood cells in an under-oil microchannel with single-cell trapping take a monolayer of cells, which is
essential for uncompromised optical access to the cells with unprocessed whole blood and in situ
phenotypic assays (e.g., cell segmentation and tracking). The unique physics and open-fluid
microenvironment enabled by ELR-empowered UOMS in μ-Blood (Section I in SI, Supplementary Fig.
1) provides an exclusive method to trap whole blood and microbial pathogens with open microfluidic
configurations.

Neutrophil recruitment in under-oil open microchannels
Immune cell recruitment - the movement of a subset of immune cells into and out of specific
compartments against chemical stimuli, has been intensively studied in inflammation/resolution of
inflammation, providing biomarkers and treatment targets in a variety of diseases39. Here we test and
validate neutrophil recruitment from a microliter of unprocessed whole blood input per microchannel in
μ-Blood.

As the first line of defense, neutrophils are known to be highly sensitive and responsive to a broad
range of chemoattractants from cells, damaged tissues, and pathogens. Here we first test if fMLP - a
commonly used bacterial peptide (M.W. 437.56 g/mol) to study neutrophil recruitment via chemotaxis -
can recruit neutrophils directly from a drop of unprocessed whole blood in μ-Blood. In this pilot study, we
used microchannels 2-2-L0.5-W0.1 (w ECM) [collagen I, ~2 mg/mL in RPMI (basal media only)]
(Methods). We then loaded 1 μL of whole blood [with anticoagulant citrate dextrose (ACD), no cell stains
or other additives unless otherwise stated] through the oil overlay directly onto one of the spots connected
by the microchannel, followed by loading 1 μL of fMLP [100 nM in RPMI (basal media only)] to the
other spot (Fig. 3a) under a microscope. In just a few minutes, some cells started to respond and squeeze
into the microchannel with a noticeable cell deformation (Supplementary Movie 1) with a media layer
thickness of about 1.6 μm (Fig. 2b, inset). In our previous publication30, we characterized the spontaneous
establishment of a gradient through the micrometer-scale under-oil microchannels, which in this case
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provides a chemoattractant gradient signaling that triggers cell migration (Section II in SI, Supplementary
Fig. 3).

Fig. 3 Neutrophil recruitment in response to fMLP (bacterial peptide) in μ-Blood. a, Cell migration
from a drop (1 μL) of unprocessed whole blood through an under-oil microchannel [2-2-L0.5-W0.1 (w
ECM, collagen I, 2 mg/mL, mcherry)]. (Insets) Close-up images showing the cell morphology in (left) and
migrating out (right) of the microchannel. b, Comparison of cell migration between whole blood with RBC
lysis and PBMCs (peripheral blood mononuclear cells, i.e., white blood cells with most neutrophils
depleted) (Methods) against fMLP. Hoechst [a cytoplasmic membrane-permeable DNA stain, 1:200
dilution, blue (Excitation/Emission or Ex/Em 350 nm/461 nm)] was added to the cell stocks in RPMI (basal
media only) to visualize nucleus morphology. Negative control (-) refers to no fMLP. c, Representative
microscopic images (composite: bright field + Hoechst) corresponding to each condition in (b). The
channel oil-media boundaries on the substrate are highlighted by the white dash-dotted lines. (Insets)
Zoomed-in images of the multi-lobed nucleus morphology of the cells in and migrating out of the
microchannel. d, Comparison of circularity of nuclei (Supplementary Fig. 2) between the cells in and
migrating out of the microchannel. e, Close-up images showing the morphology (cytoplasm and nucleus)
change of cells mitigating through a microchannel in (c) - whole blood RBC lysis + fMLP. f, Cell migration
speed analysis of the individual pioneer cells (i.e., cells leading the migration front). g, Cell migration
tracks in (f) recorded in ImageJ (Methods). The entrance plumes are marked out by the contour lines
(colored dashed lines). Error bars are mean + standard deviation (S.D.) from ≥3 replicates. *P ≤ 0.05, **P
≤ 0.01, ***P ≤ 0.001, and ****P ≤ 0.0001. “ns” represents “not significant”.
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To identify the cell type in migration, we adopted a multi-metric method including nucleus
morphology (enabled by Hoechst staining), cell migration speed (via cell tracking), and
chemoattractant/blood cell depletion control. We first compared the blood cells with and without
neutrophil depletion, specifically whole blood with RBC lysis (i.e., white blood cells) versus peripheral
blood mononuclear cells (PBMCs) (i.e., white blood cells with >90% neutrophils depleted) (Methods)
(Fig. 3b,c, Supplementary Movie 2) against fMLP (100 nM). In the fMLP-free negative control (-) groups
and the PBMC (i.e., neutrophil depletion) group, little or very minor cell migration (<5 cells in the
fLMP-free groups, <10 cells in the PBMC-fMLP group, versus >50 cells in the whole blood-RBC
lysis-fMLP group) was observed in the same length of time for 2 h. The cells migrating toward fMLP in
the whole blood-RBC lysis group all displayed a multi-lobed nucleus morphology (Fig. 3c). The
migrating cells dynamically changed their morphology (cytoplasm + nucleus) in response to the position
relative to the channel, taking nearly round-shaped cytoplasm and tight nucleus when out of the channel
and expanded cytoplasm and looser nucleus when in the channel (Fig. 3d,e). These metrics indicate the
cells in the channel are polymorphonuclear leukocytes (PMNs) - primarily consisting of neutrophils (the
natural abundance of neutrophils 60-70%, eosinophils 1-6%, and basophils ~1%). Further discriminating
the subtypes of PMNs can be achieved by molecular assays, e.g., polymerase chain reaction (PCR),
immunofluorescent staining (IFS). It is worth noting that the small percent of PMNs migrating in the
fMLP-free conditions could be an interesting phenomenon/mechanism to further investigate. At last, we
further looked into the migration speed (Fig. 3f,g). From a manual cell tracking analysis (Methods), the
migration speed of the pioneer cells (in the microchannels with ECM coating) fell within the range of
0.2-0.3 μm/s, which is consistent to the reported migration speed of human neutrophils40 that takes the top
tier of immune cell migration speeds followed by T cells41, B cells42 at 0.1-0.2 μm/s, monocytes43,
macrophages,43 and NK cells44 at <0.06-0.07 μm/s. With these metrics, we conclude that the cells
migrating toward fMLP in μ-Blood are PMNs, predominantly consisting of neutrophils.

The influence of channel dimensions (Section II in SI, Supplementary Fig. 3, Supplementary Table 1,
Supplementary Table 2, Supplementary Movie 3-1, Supplementary Movie 3-2, Supplementary Movie
3-3) and anticoagulants [ACD versus ethylenediaminetetraacetic acid (EDTA), Section III in SI,
Supplementary Fig. 4, Supplementary Movie 4] on neutrophil recruitment are discussed in detail in SI. To
pick a specific channel dimension in μ-Blood depends on the needs in an assay that include i)
requirements to perform cell segmentation, tracking, and image/video analysis, ii) ease of operation (e.g.,
sample loading, single-cell aspiration), and iii) workspace and throughput (i.e., how many channels per
device). In the following sections, we specify the channel dimension selection case by case. Regarding the
influence of anticoagulants on neutrophil migration, EDTA (at the standard blood collection concentration
- 1.8 mg/mL) strongly inhibits neutrophil migration in μ-Blood. In comparison, ACD (at the standard
blood collection concentration - ACD-A solution 1:10 dilution to whole blood) allows neutrophil
migration comparable to the anticoagulant-free blood condition. In addition, μ-Blood can run finger prick
blood directly without any anticoagulant (Supplementary Fig. 4c), which greatly increases the flexibility
of blood collection methods and donor conditions (e.g., newborns with limited blood draw).

Altered neutrophil activation from in vivo to ex vivo
Immune cells that form the central defense system in our body are extremely sensitive to the
environmental factors to which they are exposed. When they get pulled out of their original niche (e.g.,
blood, tissue), the immune cells get non-specifically activated without being exposed to/challenged by
operator-defined stimuli, simply due to the altered microenvironment. For example, neutrophils sense
("know") RBCs in blood22. If neutrophils get pulled out of blood and lose the signal from RBCs, they get
activated spontaneously. In addition, our studies and some recent works from other research labs showed
that immune cells take a noticeably altered activation kinetics when kept in whole blood compared to
standard culture media usually supplemented with animal serum. Overall, the altered immune cell
activation can be attributed to a synergy of physiological factors including autologous signaling
molecules, constituent cells, and oxygen homeostasis/kinetics. Running immune cell functional assays in
unprocessed autologous whole blood is envisioned as necessary to improve the extraction of
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donor-specific information of the target immune cells. Besides the altered cell activation and loss of
donor-specific information during and after transition from in vivo to ex vivo, the inherent sensitivity of
immune cells leads to significant variation/inconsistency from cell isolation (Section IV in SI,
Supplementary Fig. 5), which not only adds extra operation steps that burnden the assay turnaround
time/cost but also compound the parallel comparison of the results from different sources.

Comparison of neutrophil non-specific activation between whole blood and isolated neutrophils in
different media conditions in μ-Blood
The original driver of developing the μ-Blood method was to minimize the observer artifacts from
exposing the target immune cells to a suboptimal or non-physiological environment and further improve
the extraction of donor-specific information and assay consistency. Our previous study on neutrophil
activation ex vivo revealed that isolated neutrophils get activated non-specifically with a high variability -
for example, in 24 h, 384-well plate, 60K neutrophils in 20 μL RPMI + 10% fetal bovine serum (FBS) +
1% penicillin/streptavidin (Pen/Strep) per well, standard CO2 incubator [37 oC, 18.6% O2, 5% CO2, 95%
relative humidity (RH)]; and much more quickly in 12 h, 384-well plate, 60K neutrophils in 20 μL RPMI
+ 10% FBS + 1% Pen/Strep per well, onstage incubator (37 oC, 21% O2, 5% CO2, 95% RH). The isolated
neutrophils get pulled out of their original whole blood environment and then cultured/interrogated in an
artificial cell culture media with altered nutrient level and signaling molecules (e.g., autologous plasma
versus animal serum), constituent cells, and oxygen availability [e.g., 5% O2 in venous blood, 13% O2 in
arterial blood, versus 21% O2 in air, 18.6% O2 in standard cell incubator]. By contrast, neutrophils remain
stable (i.e., non-activated) in whole blood ex vivo for at least 2 to 3 days. In whole blood, even if already
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drawn out of the body, neutrophils are still exposed to autologous signaling molecules and constituent
cells. Moreover, the results from an automated oxygen optical sensor unit showed that whole blood is able
to retain the physiological oxygen level (e.g., 5% O2 in venous blood) outside of the body in air for 2 days
(Supplementary Fig. 6). These studies together explain the distinct neutrophil activation kinetics in whole
blood compared to an artificial cell culture environment.

Here, we directly compare neutrophil non-specific activation between unprocessed whole blood and
isolated neutrophils on a μ-Blood device against different culture media conditions - 100% autologous
platelet-free plasma (A-PFP), 100% heterologous (i.e., donor-mismatched, prostate cancer in this
experiment) PFP (H-PFP), 100% FBS, RPMI (the standard basal media for culturing suspension cells) +
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20% A-PFP, RPMI + 20% H-PFP, and RPMI + 20% FBS (Fig. 4a-c). To keep a donor-specific autologous
microenvironment, we used microchannels prepared without ECM coating and with double-oil overlay
for long-term (days) assays (Section V in SI, Supplementary Fig. 7).

Fig. 4 Side-by-side comparison of neutrophil non-specific activation (i.e., baseline cell death
without operator-defined stimuli) between whole blood and isolated neutrophils for 3 days in
μ-Blood. a, Schematic showing the preparation steps of an under-oil microchannel (without ECM coating)
and sample loading with double-oil [i.e., silicone oil (20 cSt) or “SO20” + fluorinated oil (Fluorinert FC-40)
or “FC-40”] overlay (Section V in SI, Supplementary Fig. 7). The spots and channel are not in scale for
illustration. b, Camera photos showing the layout of the μ-Blood device. The yellow boxes indicate the
region of interest (ROIs) in (d) and (e). c, The culture media conditions (1 to 6) for channel sweeping and
preparation of the fMLP solutions. d, Bright-field images showing the optical access and cell seeding
density of isolated neutrophils at 0 h (i.e., right afte cell seeding) on the μ-Blood device. The neutrophil
seeding density is defined by the natural abundance in the whole blood sample (i.e., 2× of neutrophil
count from EasySep isolation with an average yield of 50%). (Callouts) Neutrophil stages identified by
bright-field cell morphology. e, Non-specific activation (Sytox+: late apoptosis and NETosis) of neutrophils
at 3 h on μ-Blood device. (Callouts) Neutrophil stages identified by bright-field and Sytox (a cytoplasmic
membrane-impermeable DNA stain) cell morphology. f, Comparison of non-specific activation of
neutrophils between whole blood and isolated neutrophils up to 3 days on the μ-Blood device. The y axis
is the mean fluorescence intensity from the Sytox channel normalized to the total number of cells in the
field of view in each condition. g, Sytox+ cell percentage (i.e., Sytox+ cell count/total cell count × 100%) at
3 h after cell seeding. The non-specific activation of isolated neutrophil on the μ-Blood device ranges from
about 10% to 70% in different culture media conditions. Error bars are mean + S.D. from ≥3 replicates. *P
≤ 0.05, **P ≤ 0.01, ***P ≤ 0.001, and ****P ≤ 0.0001. “ns” represents “not significant”.

On the μ-Blood devince, we found that isolated neutrophils got non-specifically activated ranging
from 10% to 70% in 3 h (under-oil 2 mm spot, 1500 cells/μL per spot, onstage incubator). By contrast,
neutrophils in whole blood on the same device remain stable with minimal (<0.1%) non-specific
activation for more than 3 days (under-oil 2 mm spot, 1 μL whole blood per spot, onstage incubator) (Fig.
4d-g). These results are consistent with our previous study of non-specific activation of isolated
neutrophils ex vivo (Supplementary Fig. 5). The altered and random neutrophil activation in an artificial
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culture environment underlines the necessity of using unprocessed whole blood and autologous plasma to
perform immune cell functional assays. μ-Blood can be performed with or without ECM (Fig. 2c,d). If
ECM is used, it is worth noting that the source of ECM is limited to animals (e.g., murine, bovine). In
ECM-free μ-Blood, all the reagents involved are from the same whole blood sample for a more
donor-specific autologous microenvironment.

Translational application - donor-derived neutrophil functional heterogeneity
In this section, we demonstrate the translational application of ECM-free μ-Blood with clinical blood
samples. We first compared and quantified neutrophil non-specific activation in a pilot project with a
donor pool of 10 healthy (self-reported) donors and 26 cancer patients (Section VI in SI, Supplementary
Fig. 8, Supplementary Fig. 9). The results showed that neutrophils from healthy donors were noticeably
more sensitive/responsive to the altered environmental factors from in vivo to ex vivo compared to cancer
patients. The sensitive neutrophils from healthy donors featured a more N1-like (i.e., pro-inflammatory)
phenotype and by contrast, the desensitized neutrophils from cancer patients displayed a more N2-like
(i.e., anti-inflammatory) phenotype (Supplementary Fig. 9).

Here, we further characterize the donor-derived neutrophil functional heterogeneity by comparing the
recruitment and activation of neutrophils against fMLP and the response to live bacteria (S. aureus) in
μ-Blood (Fig. 5). In these experiments, we used venipuncture blood (w ACD) from healthy donors and
cancer patients. For the fMLP experiments, we chose the microchannels 2-2-L0.26-W0.04 (w/o ECM)
prepared with 100% A-PFP that allow i) a relatively narrow migration front in the microchannel with 1-2
cells in parallel (Supplementary Movie 3-2), and ii) a relatively small neutrophil count (<50) in/through
the channel to facilitate cell count/tracking (Supplementary Fig. 3d-f). For the bacteria experiments, we
chose the microchannels 2-2-L0.5-W0.1 (w/o ECM) prepared with 100% A-PFP that allow i) a broader
migration front in the microchannel with 3-8 cells in parallel (Supplementary Movie 3-1, Supplementary
Movie 3-3), and ii) neutrophil-pathogen interaction in an A-PFP environment with RBCs (Fig. 2c,
Supplementary Movie 3-3).

Whole blood samples from a healthy donor (Healthy122) and a cancer patient (Prostate873) were
compared at an early stage of 2-3 h and a later stage at around 24 h. Against 100 nM fMLP in A-PFP at 3
h, Healthy122 showed a much higher recruitment of neutrophils (average 19 neutrophils/channel)
compared to Prostate873 (average 7 neutrophils/channel), accounting for average 60% less requirement of
Prostate873 neutrophils at the early stage (Fig. 5a,b). After the first 3-h timelapse on a microscope in an
onstage incubator, the μ-Blood device was kept in a standard CO2 incubator for the later time point. At 22
h, Prostate873 neutrophils showed a significantly increased recruitment to a level comparable to
Healthy122 neutrophils at 3 h. In comparison, the number of neutrophils on the fMLP spot from
Healthy122 decreased significantly from average 19 neutrophils/channel at 3 h to average 11
neutrophils/channel at 22 h (Fig. 5a,b). We further quantified the neutrophil activation rate at 22 h by
segmenting cells on the fMLP spots with the morphology of nuclei - decondensed (i.e., activated) (Fig.
4e, Fig. 5c-e). The results showed that the activation rate of Healthy122 neutrophils (average 72%) was
much higher than Prostate873 neutrophils (average 13%). The quick and strong activation and
decondensation of nuclei account for the drop of neutrophil count on Healthy122 in this 24-h assay (Fig.
5a,b).

Against a given stimulus, a low recruitment of neutrophils can be attributed to #1) down-regulated
neutrophil count in whole blood (i.e., fewer neutrophils/μL of whole blood), #2) reduced motility, and #3)
other donor-derived heterogeneities that lead to reduced responsiveness or longer “induction time” to
respond to stimuli. Our results of neutrophil count from direct whole blood neutrophil isolation showed
that cancer patients typically come with a higher neutrophil count (average 4000 cells/μL, 26 patients)
compared to healthy donors (average 3000 cells/μL, 10 donors) (Supplementary Fig. 8c). Further, the
migration speed analysis (Fig. 5f,g, Supplementary Movie 5) showed that Healthy122 and Prostate873
neutrophils came with similar motility (average 0.2-0.3 μm/s) against fMLP in 3 h. Prostate873
neutrophils seemed to be slower in migration speed but had no statistical significance compared to
Healthy122 neutrophils. Together, these fMLP-test results (Fig. 5) indicate that the less recruitment of
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Fig. 5 Comparison of neutrophil function including recruitment and activation against fMLP
between a healthy donor and a cancer patient for 24 h in μ-Blood. a, Neutrophil recruitment from 1 μL
of unprocessed whole blood at 3 h and 22 h against 100 nM fMLP. The microchannels [2-2-L0.26-W0.04
(w/o ECM)] were prepared with A-PFP and double-oil overlay by under-oil sweep (Fig. 4a). Prostate873
neutrophils showed (1-7/19) × 100% = 63% less recruitment at 3 h and then slowly increased to a similar
level at 22 h compared to Healthy122 neutrophils. The decrease of neutrophil count of Healthy122 at 22 h
compared to 3 h is attributed to the high activation rate of neutrophils shown in (c). b, Representative
microscopic images (Hoechst fluorescence from nuclei) of (a). The yellow cross signs indicate the
neutrophils found on the fMLP spots from migration. It is worth noting that Hoechst (1:200 dilution) shows
a high background when used in human plasma but nearly no background in FBS. (Insets) Zoomed-in
images of neutrophil nuclei. c, Neutrophil activation rate (%) - the number of neutrophils with
decondensed nuclei (i.e., activated)/the total number of neutrophils in/through the channel × 100%.
Prostate873 neutrophils showed significantly lower activation rate (13%) compared to Healthy122
neutrophils (72%) at 22 h. It needs to be noted that the total number at 3 h was used to calculate the
activation rate of Healthy122 neutrophils at 22 h to compensate for the drop of neutrophil count. d,
Particle area of nuclei at 22 h. The mean particle area of nuclei from Healthy122 neutrophils is 1400
pixels/500 pixels = 2.8 times of that from Prostate873 neutrophils due to decondensation of nuclei. e,
Representative microscopic images (composite: bright-field + Hoechst fluorescence of nuclei) show the
decondensed and non-decondensed nuclei (Fig. 4e) at 22 h on the fMLP spots. f, Migration speed of
Healthy122 and Prostate873 neutrophils in 0-1 h and 1-3 h. g, Representative cell migration tracks of (f).
Error bars are mean + S.D. from ≥3 replicates. *P ≤ 0.05, **P ≤ 0.01, ***P ≤ 0.001, and ****P ≤ 0.0001.
“ns” represents “not significant”.

15

All rights reserved. No reuse allowed without permission. 
(which was not certified by peer review) is the author/funder, who has granted medRxiv a license to display the preprint in perpetuity. 

The copyright holder for this preprintthis version posted August 31, 2023. ; https://doi.org/10.1101/2023.08.28.23294744doi: medRxiv preprint 

https://doi.org/10.1101/2023.08.28.23294744


neutrophils from cancer blood is related to a reduced responsiveness in response to stimuli, which is likely
to be caused by other donor-derived heterogeneities rather than neutrophil count in whole blood and
motility.

fMLP is a bacteria peptide and a standard chemoattractant for studying/quantifying neutrophil
chemotaxis. Live bacteria secrete many chemicals that may lead to a different neutrophil response
compared to pure fMLP. Next, we switched to live bacteria (GFP-labeled S. aureus) to test neutrophil
response and pathogen control in μ-Blood with whole blood and an A-PFP environment with autologous
RBCs (Fig. 6a,b). Here, we also compare a healthy donor (Healthy109) and a cancer patient
(Prostate624). The results showed that Healthy109 neutrophils came with a significantly higher
recruitment toward S. aureus at 2 h compared to Prostate624 neutrophils (Fig. 6a), consistent with the
recruitment results toward fMLP (Fig. 5a). In the 2-2-L0.5-W0.1 (w/o ECM) microchannels with a
channel height of about 2.3 μm (Fig. 2b, inset), neutrophils were able to smoothly navigate through the
RBC monolayer in the microchannel (Fig. 2c) and phagocytize bacteria quickly (in <2 min) after
engagement (Fig. 6b). The phagocytosis process was readily identified by internalization of GFP-S.
aureus blobs into neutrophils and then getting carried over with neutrophil movement (Supplementary
Movie 6). The phagocytosis events were primarily observed with Healthy109 neutrophils in the
microchannels. The apparently reduced phagocytosis from Prostate624 neutrophils could be a direct result
of less recruitment and thus lower density of neutrophils in the microchannels, while the possibility of
reduced phagocytosis ability is not ruled out and will be further investigated. Essentially different from
fMLP, live bacteria proliferate and modify the immune-pathogen microenvironment over time
dynamically. Longer (>2 h) neutrophil-S. aureus interactions were studied in μ-Blood but not included in
this report.
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Further, the migration speed analysis (Fig. 6c,d) revealed that Prostate624 neutrophils were able to
respond and migrate toward S. aureus through a monolayer of RBCs but in a much slower migration
speed (average 0.05 μm/s) up to about 0.2 μm/s. By contrast, Healthy109 neutrophils, in the parallel
testing environment (i.e., against S. aureus and through RBCs), responded much quicker and stronger
with a high migration speed (average 0.28 μm/s) up to about 0.6 μm/s. This distinct difference of
migration speed contributes to the less recruitment toward S. aureus from Prostate624 compared to
Healthy109 (Fig. 6a). These bacteria-test results further indicate the reduced responsiveness of
neutrophils from cancer patients in response to stimuli.

Fig. 6 Comparison of neutrophil response to live bacteria (S. aureus) between a healthy donor and
a cancer patient for 2 h in μ-Blood. a, Neutrophil recruitment from 1 μL of unprocessed whole blood in 2
h against S. aureus [GFP-labeled, 5 × 108 CFU/mL in Mueller Hinton Broth (MHB)]. The microchannels
2-2-L0.5-W0.1 (w/o ECM) were prepared with A-PFP and double-oil overlay by under-oil sweep (Fig. 4a).
Prostate624 neutrophils showed (1-4/11.5) × 100% = 65% less recruitment at 2 h compared to
Healthy109 neutrophils. b, Representative microscopic images (composite: bright-field + GFP
fluorescence from S. aureus) of (a). The responsive neutrophils migrating into the channels are marked
out by the dashed line boxes. The green dashed-line box highlights the phagocytosis of GFP-S. aureus
by neutrophils from the healthy donor. c, Migration speed and d, representative cell migration tracks of
(c). Healthy109 neutrophils showed significantly higher migration speed (average 0.28 μm/s) compared to
Prostate624 neutrophils (average 0.05 μm/s). Error bars are mean + S.D. from ≥3 replicates. *P ≤ 0.05,
**P ≤ 0.01, ***P ≤ 0.001, and ****P ≤ 0.0001. “ns” represents “not significant”.

Long-term (days) neutrophil kinetics between healthy-donor and cancer-patient neutrophils
The role of neutrophils in cancer diseases and treatments continues to gain attention45,46. So far most of the
neutrophil functional assays were performed on animal models47,48 as neutrophil is notorious with its
inherently high sensitivity and difficulty to manipulate ex vivo49. The reported in vitro neutrophil
functional assays were typically performed with a pure isolate of neutrophils or pre-processed whole
blood (RBC lysis or dilution with artificial media and animal serum) with a standard assay time window
for a few hours. Long-term (days) in vitro neutrophil functional assays were rarely explored due to the
challenges from both biology (i.e., neutrophil sensitivity and non-specific activation) and platform
engineering. The high neutrophil sensitivity leads to random, non-specific activation after the cells are
pulled out of whole blood (Fig. 4, Section IV in SI, Supplementary Fig. 5, Supplementary Fig. 6). On top
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of this biological challenge and as aforementioned in the first section of Results, to perform in vitro
neutrophil functional assays with microfluidics, microchannels that support single-cell trapping are
required. The media volume in single-cell trapping microchannels falls into sub-nanoliter or picoliter
range (Section II in SI, Supplementary Table 1, Supplementary Table 2), which is extremely vulnerable to
environmental/operational factors such as media loss via evaporation (Section V in SI, Supplementary
Fig. 7a) and bubble/particle clogging.

In the previous sections, we already demonstrated the applicability of μ-Blood to perform standard
(i.e., hours) in vitro neutrophil functional assays using a microliter of unprocessed whole blood. To run
long-term (days) in vitro neutrophil functional assays, we introduced a double-oil overlay method
(Section V in SI, Supplementary Fig. 7b) to retain hydration of the single-cell trapping microchannels
under oil for days (tested up but not limited to 6 days).

Here, we prepared two μ-Blood devices to compare whole blood with isolated neutrophils and the
possible long-term neutrophil functional heterogeneity between a healthy donor (Healthy109) and a
cancer patient (Prostate624) (Fig. 7a). With the experimental design, we added fresh fMLP solution (1
μM in A-PFP) to a subset of the microchannels (×4 replicates per condition) through 3 days and then
added two different fMLP concentrations (1 μM and 10 μM in A-PFP) on Day 4 to 50-50 of the Day 1 to
Day 3 microchannels. At last on Day 6, fMLP at 10 μM in A-PFP was added to each well for the end
point. Through a 6-day assay in whole blood and the A-PFP environment, we successfully extracted the
days-long neutrophil kinetics information specific to the donor conditions in μ-Blood (Fig. 7b,c,f-h). By
contrast, the control group with isolated neutrophils provided little information reflecting no
donor-derived heterogeneity (Fig. 7d,e).

Similar to the neutrophil recruitment results in the 24-h fMLP test (Healthy122 versus Prostate873)
(Fig. 5) and the 2-h bacteria test (Healthy109 versus Prostate624) (Fig. 6), Healthy109 neutrophils
showed a quick and strong response (average 12 neutrophils/channel up to 35) in 2 h on Day 1 right after
adding fMLP (Fig. 7b, Supplementary Movie 7), however, almost no recruitment (0-1 neutrophil/channel)
was observed from Prostate624 neutrophils (Fig. 7c). This recruitment differential was retained through 3
days with an opposite trend of kinetics in neutrophil recruitment - Healthy109 decreasing and Prostate624
slightly increasing over time (Fig. 7b,c). On Day 4, the recruitment differential was inverted - Healthy109
(average 0 neutrophil/channel against 1 μM fMLP, 0-3 neutrophils/channel against 10 μM) versus
Prostate624 (0-5 neutrophils/channel against 1 μM fMLP, 0-9 neutrophils/channel against 10 μM).
Further, on Day 6, Healthy109 showed no neutrophil recruitment against 10 μM. In comparison,
Prostate624 still gave a recruitment at the level of 0-4 neutrophils/channel. The results from parallelly
isolated neutrophils failed to capture the long-term neutrophil kinetics and donor-derived heterogeneity
(Fig. 7d,e) due to the quick/random non-specific activation (Fig. 4g).
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A further migration speed analysis revealed that cancer-patient neutrophils came with similar
migration speed (average 0.2 μm/s) compared to healthy-donor neutrophils from fresh blood at early stage
(Fig. 7f-h, Supplementary Movie 7). In addition, healthy-donor neutrophils retained nearly constant high
migration speed (average 0.2 μm/s) through 3 days, followed by a significantly decreased migration
speed down to average 0.1 μm/s (Fig. 7f) and an intuitively decreased recruitment (Fig. 7b). By contrast,
cancer-patient neutrophils showed reduced migration speed (down to average 0.1 μm/s) starting at
relatively early stage (Day 2 to Day 3) (Fig. 7g) but counter-intuitively increased recruitment over time
(Fig. 7c). This “abnormal” trend between migration speed and recruitment observed on cancer-patient
neutrophils, again, indicates a reduced responsiveness apparently characterized as a significantly
increased “induction time” in response to stimuli. Our hypothesis on the reduced responsiveness of
cancer-patient neutrophils is that cancer-patient neutrophils could be systematically desensitized and
primed toward more anti-inflammatory (N2-like), showing reduced responsiveness and extended
induction time against stimuli that normally trigger quick and strong pro-inflammatory (N1-like)
responses on healthy-donor neutrophils.

Discussion
Immune cells, especially neutrophils, are amongst the most sensitive cell types due to their natural
function as the first line of response/defense against an altered/abnormal microenvironment (e.g.,
damaged tissues, infections). During the transition from in vivo to ex vivo and the following interrogation,
the altered environmental factors (including temperature, nutrients/vital gas level and kinetics, signaling
molecules, constituent cells, and mechanical cues) are enough to non-specifically and randomly activate
neutrophils without operator-defined stimuli. In such cases, it is very challenging to extract the
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donor-specific information from the compromised immune cells. Moreover, the non-specific activation of
immune cells ex vivo inflicts limited assay consistency.
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Fig. 7 Comparison of neutrophil recruitment against fMLP between a healthy donor and a cancer
patient for 6 days in μ-Blood. a, A schematic and a camera photo showing the layout of two μ-Blood
devices (Device 1 - whole blood; Device 2 - isolated neutrophils; Well 1 - Healthy109; Well 2 -
Prostate624). Fresh fMLP solution in A-PFP was loaded to the device through 6 days. The devices were
imaged in a 2-h timelapse each day in an onstage incubator. After imaging, the devices were kept in a
standard CO2 incubator. b, (Healthy109) and c, (Prostate624) Neutrophil recruitment from 1 μL of
unprocessed whole blood in 2 h. d, (Healthy109) and e, (Prostate624) Neutrophil recruitment from
isolated neutrophils in 2 h. Migration speed of f, Healthy109 neutrophils and g, Prostate624 neutrophils in
6 days. h, Respretactive cell migration tracks (bright-field) of (f,g). Error bars are mean + S.D. from ≥3
replicates. *P ≤ 0.05, **P ≤ 0.01, ***P ≤ 0.001, and ****P ≤ 0.0001. “ns” represents “not significant”.

The design philosophy of the μ-Blood method is to preserve and extract a more complete set of
donor-specific information over a physiologically relevant time period (e.g., the in vivo lifespan of
neutrophils for 3-5 days) by keeping and interrogating the target immune cells in the autologous whole
blood microenvironments. Various microfluidic systems (predominantly closed-chamber/channel
systems) have been used to perform in vitro immune cell functional assays with improved control and
thus relevance of the interrogation microenvironments compared to in vivo. Specifically, the use of whole
blood as the assay input (versus isolated cells) represents a milestone in this direction as it streamlines the
workflow by removing most of the blood cell isolation steps and more importantly, reduces the
operator-derived inconsistencies and provides for long term assays. The latest whole blood-based immune
cell functional assay uses whole blood but still diluted in a cell culture media supplemented with animal
serum, which makes it suboptimal compared to an unprocessed whole blood environment. In addition, the
closed-channel configuration makes it difficult to have free, nondestructive physical access to the single
cells of interest on the device for off-chip downstream analyses, e.g., single-cell sequencing.

Different from the closed system-based immune cell functional assays, the proposed μ-Blood method
in this report was developed based on ELR-empowered UOMS - a newly introduced sub-branch in open
microfluidics with the state-of-the-art lateral resolution (i.e., micrometer scale versus millimeter scale)
and open-fluid controls (including open-fluid single-cell trapping, transformatively improved flow range,
and on-demand open-fluid valves). Directed by the design philosophy aforementioned, μ-Blood uses a
small volume (≤1 μL per channel) of unprocessed whole blood as the assay input and autologous plasma
to prime the microchannels. Multiple phenotypic readouts can be continuously collected through a time
course or timelapse for both short-time (in 24 h) and long-time (3-5 days) assays. Moreover, the
open-system configuration of μ-Blood allows the operators to seamlessly and selectively collect single
cells of interest anytime and anywhere during and after an assay, e.g., using a single-cell aspirator directly
on the device under the microscope, which allows single-cell phenotypic segmentation - a highly desired
function in in vitro immune cell functional assays to study inherent immune heterogeneity.

The follow-up directions that aim to incubate μ-Blood to a mature, commercially available immune
cell functional assay platform include: i) development of numerical models to predict the fluid dynamics
and mass transport in the under-oil microchannels, especially with complicated/customized patterns; ii)
development of an onstage, automated single-cell manipulator for high-throughput sample loading and
collection; iii) integration with multiple optical spectroscopy (including multiphoton, Raman, IR) for
label-free, in situ, single-cell biochemical analyses; and iv) development of machine learning algorithms
for real-time single-cell phenotype segmentation (including cell/nucleus morphology, pathogen control,
and degradation of ECM) and cell tracking.

In translational research future studies using μ-Blood, broader diseases including multisystem
inflammatory syndrome (MIS), autoimmune diseases, and infectious diseases will be investigated with a
large (>10) donor pool. Specifically, innate-adaptive immune crosstalks (e.g., neutrophil-T cell,
neutrophil-monocyte/macrophage), cancer-immune-microorganism interkingdom interactions, and
antimicrobial susceptibility testing can be explored in a donor-specific whole blood microenvironment.
We envision μ-Blood (especially in its fully automated version) can be directly used in hospitals/clinics
for high-throughput immune cell functional screening with high extraction of donor-specific information
and assay consistency. Especially, μ-Blood provides an optimal solution where access to a large volume of
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whole blood sample is limited or impossible, e.g., the newborns. μ-Blood also provides an easy-to-adopt,
easy-to-use, and multi-functional platform that supports the studies in fundamental immunology,
especially where environmental factors play a pivotal role on the readouts at single-cell level.
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Methods
Preparation of ELR-empowered UOMS devices
Step #1) Fabrication of PDMS silane-grafted surface. Chambered coverglass [Nunc Lab-Tek-II, 2 well
(155379), #1.5 borosilicate glass bottom, 0.13 to 0.17 mm thick; Thermo Fisher Scientific] (Fig. 1b) was
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treated first with O2 plasma (Diener Electronic Femto, Plasma Surface Technology) at 100 W for 3 min
and then moved to a vacuum desiccator (Bel-Art F420220000, Thermo Fisher Scientific, 08-594-16B) for
chemical vapor deposition (CVD). PDMS-silane (1,3-dichlorotetramethylsiloxane; Gelest, SID3372.0)
(25 μL ×2 per treatment) was vaporized under pumping for 3 min and then condensed onto glass substrate
under vacuum at room temperature for 40 min. The PDMS-grafted surface was thoroughly rinsed with
ethanol (anhydrous, 99.5%), deionized (DI) water, and then dried with nitrogen for use.

Step #2) Fabrication of PDMS stamps. Photomasks were designed in Adobe Illustrator and then sent to a
service (Fineline Imaging) for printing. Standard photolithography was applied to make a master that
contains all the microchannel features. Details about photolithography can be found in our previous
publication30. Last, PDMS stamps were made by pouring a degassed (about 20 min using a vacuum
desiccator) silicone precursor and curing agent mix (SYLGARD 184, Silicone Elastomer Kit, Dow,
04019862) in 10:1 mass ratio onto the master and cured on a hotplate at 80 oC for 4 h. The PDMS stamps
were stripped off with tweezers and punched with through holes (Miltex Biopsy Punch with Plunger, Ted
Pella, 15110) at the inlet and outlet of a microchannel for the following O2 plasma surface patterning.

Step #3) O2 plasma surface patterning. The PDMS silane-grafted chamber coverglass was masked by a
punched PDMS stamp and then treated with O2 plasma at 100 W for 1 min. After surface patterning, the
PDMS stamp was removed by tweezers and stored in a clean container (e.g., Petri dish) for reuse.

Step #4) Under-oil microchannels without ECM coating - The chemically patterned chambered coverglass
from Step #3 was overlaid with 1 mL silicone oil (<100 cSt, e.g., 5 cSt or 20 cSt) for each well on the
2-well chambered coverglass. The target media was distributed onto the microchannels by under-oil
sweep (Fig. 1a). Briefly, get 20 μL of the target media in a 1-200 μL large orifice pipet tip (02-707-134,
Thermo Fisher Scientific) and then drag the hanging microdrop at the end of the tip through the patterned
surface. Media was spontaneously distributed onto the O2 plasma-treated areas only. For double-oil
overlay [i.e., silicone oil (20 cSt) + fluorinated oil (Fluorinert FC-40)], we first prepared the under-oil
microchannels under silicone oil (20 cSt) with the target media by under-oil sweep. Next, we added 1 mL
Fluorinert FC-40 (1.85 g/mL at 25 °C) for each well on the 2-well chambered coverglass directly into the
silicone oil (20 cSt, 0.95 g/mL at 25 °C). Due to the high density of the fluorinated oil and immiscibility
with silicone oil, the fluorinated oil spontaneously replaces silicone oil in a well and pushes it to the top
layer. At last, the silicone oil was removed using pipet at the four corners in a well.

Step #5) Under-oil microchannels with ECM coating - Similar to Step#4, the under-oil microchannels
with ECM coating were prepared by sweeping a hanging microdrop of the ECM solution under oil
(silicone oil, 5 cSt). The ECM solution is collagen I (Rat Tail, about 10 mg/mL in the original bottle) 1:1
dilution in 2% N-2-hydroxyethylpiperazine-N-2-ethane sulfonic acid (HEPES) 2× PBS and then 1:1
dilution in RPMI (basal media only). The final pH of the collagen solution was adjusted to 7.4 by 0.5 M
sodium hydroxide (NaOH) endotoxin-free aqueous solution (0.5 μL of 0.5 M NaOH per 100 μL collagen
solution). After under-oil sweep, the device was kept at room temperature (~21 oC) for 1 h for
polymerization. The ECM layer effectively retains hydration of the microchannels with single-oil overlay
(Fig. 3). After the ECM layer is fully polymerized, the device is ready for sample loading.

Step #6) Sample loading before imaging. The device with oil overlay was set up under a microscope. We
first registered the xy and z positions of the microchannels with perfect focal plane (PFS) function. Next,
we loaded the blood or cell stock using pipet under oil for 1 μL/spot (Fig. 1b) throughout all the
microchannels. At last, we loaded the chemoattractant solution or pathogen inoculum at the other end of
each microchannel for 1 μL/spot. After sample loading and update of the xy and z positions, the device is
ready for imaging or timelapse.

Whole blood collection
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All blood samples were drawn according to Institutional Review Boards (IRB) approved protocols per the
Declaration of Helsinki at the University of Wisconsin-Madison in the Beebe Lab (IRB# 2020-1623,
healthy donors) and in the Lang Lab (IRB# 2014-1214, cancer patients). Whole blood was collected with
standard Vacutainer tubes (EDTA tube, BD, 366643; ACD tube, BD, 364606) (Supplementary Fig. 4a).
Finger prick blood (90 μL) was collected using a pipet and following the standard finger prick lancet
(Microtainer, contact-activated, BD, 366594) protocol into a 0.6 mL sterile Eppendorf tube pre-loaded
with 10 μL of ACD-A solution (Sigma Aldrich, C3821-50 mL) (Supplementary Fig. 4b). All the whole
blood samples were stored in a standard CO2 incubator (Thermo Fisher Scientific, HERACELL VIOS
160i) at 37 oC before use.

RBC lysis
The whole blood RBC lysis was performed using BD Pharm Lyse buffer (BD Biosciences, 555899)
following the user’s instruction. The white blood cells after RBC lysis were spun down at 200 g/4 min
and then resuspended to the target media for 5× of the original concentration in blood [e.g., the white
blood cells from 1 mL whole blood was resuspended into 200 μL of RPMI (basal media only)].

Neutrophil isolation
Neutrophils were isolated from whole blood using magnetic bead-based negative selection. Two negative
selection kits - MACSxpress Whole Blood Neutrophil Isolation Kit, human (Miltenyi Biotec,
130-104-434) and EasySep Direct Human Neutrophil Isolation Kit (STEMCELL, 19666) - were
compared. In MACSxpress isolation, RBCs were further depleted from the neutrophil pellet using BD
Pharm Lyse buffer, according to the manufacturer’s instruction. In EasySep isolation, the neutrophil pellet
was directly resuspended in the target media for further experiments. Due to the relatively low
non-specific activation of neutrophils from isolation (Supplementary Fig. 5c), EasySep was used
throughout the μ-Blood project. RPMI (basal media only) was used as the isolation buffer. Cell count of
each isolation was obtained using a hemocytometer (LW Scientific) (Supplementary Fig. 8c).

PBMC isolation
PBMCs were isolated from whole blood using SepMate-50 PBMC Isolation Tubes (STEMCELL, 85450)
with Lymphoprep Density Gradient Medium (STEMCELL, 07801), according to the manufacturer’s
instructions. RPMI (basal media only) was used as the isolation buffer. After isolation, the PBMC pellet
was directly resuspended in the target media for 5× of the original concentration in blood. Cell count of
each isolation was obtained using a hemocytometer.

Autologous plasma separation
Autologous plasma was separated from the same whole blood sample along with neutrophil and PBMC
isolations. To get PFP (i.eplatelet-free plasma), the whole blood tube was spun at 1000 g/10 min
(Eppendorf, Centrifuge 5702, brake on) first. The supernatant was transferred to several 1.5 mL sterile
Eppendorf tubes at 1 mL/tube. The supernatant tubes were then spun at 10000 g/10 min (Eppendorf,
Centrifuge 5424, brake on). The supernatant (i.e., PFP) in the Eppendorf tubes was aliquoted and stored at
a -80 oC freezer (Thermo Fisher Scientific, Forma 900 Series) for future use. The aliquots needed in an
experiment were thawed at room temperature (~21 oC) with only one freeze-thaw use.

MAGPIX neutrophil-related cytokine analysis
Multiplexed protein secretion analysis was performed with plasma samples (PFP, see Autologous plasma
separation above) and conditioned media, using the MAGPIX Luminex Xmap system (Luminex) with a
custom-built bead panel (Thermo Fisher Scientific, Human ProcartaPlex Mix&Match 18-plex,
PPX-18-MXZTFFM), per the manufacturers’ protocol. Data of conditioned media are pooled from 3
replicates. Samples were frozen at -80 °C from the time of collection until the assay was performed.
Secreted protein levels were displayed as z-scores in a heat map generated by GraphPad Prism 10.0.1.
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Microscopic imaging
Bright-field, fluorescence images and videos were recorded on a Nikon Ti Eclipse inverted
epifluorescence microscope (Nikon Instruments). The chambered coverglass with oil overlay was kept at
37 oC, 21% O2, 5% CO2, and 95% RH in an onstage incubator (Bold Line, Okolab) during imaging or
timelapse. After imaging on the microscope, the μ-Blood devices were moved to and kept in a standard
CO2 incubator (37 oC, 18.6% O2, 5% CO2, and 95% RH) before the charazterizaiton for the next time
point.

Nucleus circularity analysis
The fluorescence images of Hoechst (30× magnification) were batch processed and analyzed using a
customized Java code (Github - https://github.com/jcai0791/Neutrophil-Project) calling functions from
Fiji ImageJ (Supplementary Fig. 2). The workflow includes: 1) Open Fiji ImageJ. 2) Analyze → Set
Measurements… (select “Area”, “Perimeter”, and “Shape descriptors”). 3) Open a Hoechst image (Image
→ Type → 16-bit). 4) Process → Subtract Background… (Rolling ball radius: 50 pixels). 5) File → Save
As → Jpeg… (use default file name). 6) Image → Adjust → Threshold… (pick a Method, e.g., Minimum,
select “Dark background”). 7) File → Save As → Jpeg… (use default file name+Threshold-“Method,
e.g., Minimum”). 8) Analyze → Analyze Particles… [Size (μm2): 0-Infinity, Circularity (0.00-1.00),
Show: Bare Outlines]. 9) File → Save As → Jpeg… (use default file name+Outlines). 10) Save Results
(click the “x” button and select “Save”, use default file name.csv).

Area fraction analysis
The fluorescence images of Sytox and Annexin V (4× magnification) were batch processed and analyzed
using a customized Java code (Github - https://github.com/jcai0791/Neutrophil-Project) calling functions
from Fiji ImageJ (Supplementary Fig. 10a). The workflow includes: 1) Open Fiji ImageJ. 2) Analyze →
Set Measurements… (select “Area fraction”). 3) Open a set of the original .nd2 images with Sytox and
Annexin V channels (Image → Type → 16-bit). 4) Image → Duplicate… (Separate the Sytox and
Annexin V channels by making a duplicate). 5) Process → Subtract Background… (Rolling ball radius:
50 pixels). 6) Image → Adjust → Threshold… (pick a Threshold Method, Default for the Sytox channels,
or MaxEntropy for Annexin V channels, select “Dark background”). 7) Analyze → Measure. 8) File →
Save As → Jpeg… (use “default file name+Threshold Method-Sytox or Annexin V”). 9) Save Results
(File → Save as… “file name.csv”). The data points in the .csv datasheet files were organized in the order
of time points with conditions under each time point from the group of Sytox or Annexin V channels.

0 h 1 h …

Condition a / / /

Condition b / / /

… / / /

10) To plot the data points, we transposed the datasheet in the order of conditions with time points under
each condition from the group of Sytox or Annexin V channels.

Condition a Condition b …

0 h / / /

1 h / / /
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… / / /

11) The sorted data were plotted in GraphPad Prism 10.0.01.

Clumping analysis
The fluorescence images of Sytox (4× magnification) were batch processed and analyzed using a
customized Java code (Github - https://github.com/jcai0791/Neutrophil-Project) calling functions from
Fiji ImageJ (Supplementary Fig. 10b-e). The workflow includes: Each image was first cropped, then split
into a grid of GRIDSIZE pixels. The mean fluorescence intensity of each grid square was measured and
then plotted in GraphPad Prism 10.0.1.

Cell counting and speed tracking analysis
Manual counting was performed in Fiji ImageJ with the timelapse videos recorded on the Nikon
microscope by counting each individual neutrophil that passes into the channel. For speed tracking,
images in a timelapse were transferred into Fiji ImageJ, where cell tracking was performed manually
using the Fiji plugin “MTrackJ”. Once “MTrackJ” is selected, the “add” option allows tracking of each
individual migrating cell. Once the manual tracking is done for each migrating cell, measurements can be
taken automatically. Measurements were created through the “MTrackJ” measurements option.

Statistical analysis
Raw data was directly used in statistical analysis with no data excluded. Data was averaged from at least 3
replicates (unless otherwise stated) and present as mean ± S.D. if applicable. The statistical significance
was specified in the figure captions. All statistical analyses were performed using GraphPad Prism 10.0.1.

Data availability
The data that support the findings of this study are available from the corresponding authors upon
reasonable request.
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